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Foreword 
Natural England commission a range of reports from external contractors to 
provide evidence and advice to assist us in delivering our duties. The views in this 
report are those of the authors and do not necessarily represent those of Natural 
England.     

Background
Ecosystem services are  the benefits we get 
from nature. These include a wide range of ben-
efits such as food, energy, clean air and water, 
regulation of risks (floods, droughts, erosion) 
and recreation or spiritual benefits.  

The Ecosystem Services Transfer Toolkit is a 
literature review of the effect of land manage-
ment actions on the provision of ecosystem ser-
vices.   

It is in the form of an Excel spreadsheet with an 
accompanying User Guide and Quick Start 
Guide.  The spreadsheet can be searched and 
queried to find evidence of the effects of specific 
land management actions on ecosystem ser-
vices provided by upland, freshwater, urban, 
lowland agriculture, coastal and marine habitats.  
It also assesses how transferable the effect of a 
land management action on ecosystem services 
may be, if done in a different place. 

The toolkit indicates the magnitude of the effect 
on an ecosystem service and the strength of the 

supporting evidence.  Where available, ab-
stracts from the peer-reviewed papers are in-
cluded in the toolkit.  

The findings published in this toolkit may be 
used by Natural England staff and anyone else 
involved in making land management decisions, 
to enable them to manage for ecosystem ser-
vices, or understand the consequences of their 
management actions on ecosystem services. 
This work built on a pilot phase that looked at 
the feasibility of developing an evidence toolkit 
for managing ecosystem services in the up-
lands. 
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Aims 
This tool-kit allows a user to select from a range of habitat types, and by inputting a 
management intervention, finding out the effect of that intervention on a list of ecosystem 
services and goods based on evidence from within the current literature. A summary of 
effects, positive and negative, is produced, and a link provided to the literature which 
provides the evidence base for that interaction. The tool-kit is intended for anyone involved 
in making land-management decisions such that the full range of effects on ecosystem 
services for that management intervention can be assessed based on the evidence available. 

Background 
This tool-kit extends a previous project completed by Cascade Ltd on behalf of Natural 
England. In that project, the only habitat reviewed was uplands and it assessed only a small 
range of management interactions. This project extends the range of habitats to freshwater, 
lowland agriculture, urban, coastal and marine. These habitats were selected to map onto 
the habitats used within current projects in the NERC Biodiversity and Ecosystem 
Sustainability (BESS) programme. The range of management interventions has also been 
extended. 

The existing tool-kit for uplands was found to be unsuitable for extension to other habitats 
and/or management interventions due to its structure, so the first stage of the project was 
to provide a format which was flexible and extendible. 

The tool-kit is provided in Microsoft Excel ver. 2007 and above, and while a relational 
database structure may have been preferable, it is more likely that users will have access to 
Excel rather than Access. All instructions here are given for Office 2010 but are very similar 
for Office 2007. 

The tool-kit is designed to appear similar to the uplands tool-kit developed by Cascade as 
this format provided information in very effective manner way. However, the way the tool-
kit works is substantially different for a number of reasons: 

i) To allow for easier input of information onto a single sheet rather than across 
multiple sheets per interaction which would have made the addition of new 
management interventions and habitats cumbersome. 

ii) To simplify the way the query runs without hidden sheets so that it is easier 
to modify. 

iii) To allow the entry of unlimited numbers of new literature sources rather than 
the limited number allowed for in the Cascade spreadsheet. 

  
 



 

iv) To allow easier export of data into other query types such as ecosystem 
services projects running at the University of York and extraction via Structured 
Query Language (SQL) if needed. 

v) To allow the sharing of a common literature source with other projects. 

Methods 

Transfer of existing data 
The uplands data already contained within the Cascade database was transferred across to 
the new spreadsheet structure. This meant also editing and checking existing references and 
adding transferability entries and evidence entries (see below). There may be small 
formatting differences between this data and newly entered data. 

Literature reviews 
To add new data on uplands, freshwater, urban, lowland agriculture, coastal and marine 
habitats, a literature review was undertaken. This was largely performed within Web of 
Science. The search terms used were ‘ecosystem’ in combination with the habitat i.e. 
‘ecosystem AND freshwater’ and then also all of the management intervention terms such as 
‘flood defences’ etc. within the title and abstract fields. These were then sifted and the full 
references, including abstract, extracted to RefWorks, an online bibliographic database. In 
addition, a search on all authors within the relevant chapters of the UK National Ecosystem 
Assessment Technical Report was performed, and relevant papers added to the database. 

This database was then extracted to an excel spreadsheet as a reference store. The 
extraction included the full reference in the format of the Journal of Environmental 
Assessment with the abstract in a separate column. As an example, a search on the 
‘ecosystem AND freshwater’ habitat category yielded over 5000 hits, of which 1600 
potentially useful sources were extracted for further consideration. 

These sources were then assessed and entered into the EST spreadsheet. 

Data assessment 
Each source was checked to see if it contained evidence for an effect of a management 
intervention on an ecosystem service or good within one of the selected habitat categories. 
If the abstract was ambiguous over the evidence, the full text of the article was checked if 
available. The selection criteria were that the paper had to contain evidence (preferably 
numerical) that an intervention could affect a service or good, even if that effect was 
measured as neutral. Papers that speculated on this in the discussion but without 
demonstrating it within the results were not included. 

If a specific service or good were not mentioned, then there was a degree of interpretation 

  
 



 

necessary. For example, if a study on peat-land demonstrated that re-wetting peat caused a 
release of methane, then it would have been tagged as affecting ‘equable climate’ in a 
negative way as the link between methane and climate change is supported by a range of 
published evidence even if the link was not proven or alluded to in the original paper. 
Similarly, if a paper demonstrated a link between increased sediment load and re-wetting 
peat, then it would be tagged as affecting ‘water quality’ since the link between sediment 
load and water quality is clear and known. However, it also known that sediment load can 
affect hatching of salmonids, so could potentially be tagged under ‘Crops livestock and fish’, 
‘food’ or even ‘recreation and tourism’ for fishing. However, as the chain of influence here is 
extended, and the original paper provided no direct evidence of this, even if it was alluded 
to in the discussion, it was not entered. 

The process of literature assessment criteria and selection process is shown 
diagrammatically as: 

 

Clearly the entry of services and goods affected by a management intervention is at least 
partly subjective. However, the entry should be viewed in the context of outcomes for which 
there is a strong and direct evidence base. This may extend beyond that contained in the 
original paper, but only to inference, not to speculation. 

The strength of that effect (++ to +, or – to -) was again somewhat subjective. If the paper 
mentioned is as a strong or substantial effect, then it was likely to be graded as ++ or --. 
However, if there was no indication of the magnitude of the effect compared with the 
background level, then the decision was to err on the side of caution and tag it with + or – 
only. 

The neutral (0) effect was either where the management intervention showed that there 
was no demonstrable effect or where two effects cancelled each other out. For example, if 

Management 
Intervention 

On a particular 
habitat 

Results in effects 
on ecosystem 

services 

  
 



 

re-wetting a peat-land had the effect of increasing Carbon dioxide sequestration, while 
increasing Methane emission such that the combined effect of the greenhouse gas flux were 
neutral, then the effect was scored as ‘0’ and this conflicting effect noted in the ‘Summary’ 
field. 

An example of how a particular reference might be tagged  for one management 
intervention and a range of services is shown below: 

Source: 

D'Arcy, B.J., McLean, N., Heal, K.V., 
Kay, D., 2007. Riparian wetlands 
for enhancing the self-purification 
capacity of streams, Water Science 
and Technology 56, 49-57. doi: 
10.2166/wst.2007.435. 

Management Intervention 

Increase planting of riparian 
vegetation 

Detoxification & purification in air, 
soils and water 

Hazard regulation 

Drinking water 

Disease/pest control 

  
 



 

Using the Spread-sheet 

Running A Query 
There are two query options available on the red tabs at the bottom of the spreadsheet, or 
via the buttons on the front ‘Instructions’ page. These are 'Query' and 'Simple Query'. They 
both work in the same way and query the same database. However 'Query' (and the Full 
NEA Query List button) returns the data in the UK National Ecosystem Assessment final 
ecosystem services and goods categories, while 'Simple Query' returns them within a smaller 
set of categories more appropriate to someone looking at the direct and measurable 
outcomes of land management. The simple query option also includes outputs such as 
‘education and health’ and ‘well-being’ which are not directly referenced from the NEA 
categories. The instructions on running a query shown below apply equally to both query 
types, but will use the 'simple query' option as an example. 

To run a query 
Go to the red ‘Simple Query’ tab at the bottom of the spreadsheet. This will take you to the 
simple query worksheet. 

In Cell A2 select the habitat you are interested from the drop-down list. 

Cell B2 will now show the list of management interventions associated with the habitat you 
have just selected in A2. Select the one you want. 

The number of effects on each ecosystem service of the management intervention within 
the habitat you have selected will now be shown in columns C to G. These show the 
numbers of literature sources that show a strong positive (++), weak positive (+), no effect 
(0), weak negative (-) and strong negative (--) effect on that service for that management 
intervention in that habitat. The strength of colour also gives a quick guide on the number of 
effects, darker green is more positives, darker red is more negatives. The studies that show 
there is no effect are in blue. 

By clicking on the ecosystem service/goods link in column B (or column I for the standard set 
of NEA categories), you will be taken to the ‘Literature’ tab (‘Evidence tab for the NEA 
categories) which will give you the index number of the data source, full title and literature 
summary for the evidence of the effect on that service on the intervention/habitat 
interaction as well as the nature of that evidence and the transferability of that evidence to 
the habitat and geographical location.  

The nature or source of the evidence is given as a code e.g. 1b. The first number in the code 
indicates the type of study from which the evidence derives, and the second letter, where 
the evidence is published. A summary of these codes is given below and can be accessed 
from the 'comments' window seen by hovering the cursor over the column heading for the 

  
 



 

'study type'. These codes were derived from D. Stone et al (2012) Natural England evidence 
reviews: development process and methods. 
 

Type Category Study Type 

1 Meta-analyses, Randomized Control Trials (RCTs) (including cluster 
RCTs), or systematic reviews of RCTs 

2 Systematic reviews of, or individual, non-randomised controlled 
trials, case-control trials, cohort studies, controlled before-and-after 
(CBA) studies, interrupted time series (ITS) studies, correlation 
studies. 

3 Non-analytical studies e.g. case reports, case series studies 

4 Expert  opinion, formal consensus 

 

Rating Rating description 

a Peer reviewed journal articles 

b International organization reports (e.g. UN, TEEB) 

c Government reports 

d Grey literature (e.g. consultancy reports, industry reports) 

 

Accessing the full abstract 
To go to the full literature citation, including the abstract (where available), click on the blue 
‘link’ next to the reference number. Note that the abstract is provided from all standard 
peer-reviewed papers which have been entered. It may not be available if the source was 
grey literature, technical reports or the internet where there is no published summary or 
abstract. 

To return to the original query, click back onto the red ‘simple query’ tab (‘query’ tab for NEA 
categories) at the bottom of the spread-sheet. 

  

  
 



 

Modifying or adding to the spread-sheet 

Entering New Data 
Go to the green ‘References’ tab. This contains all the literature. If it is not already in 
‘Reference number’ order, go to the top and click the arrow in row 1 column A and click on 
‘sort smallest to largest’ this will put the last reference at the bottom. If you think that the 
reference might already be in the list you can either use the Home>Find and Select function, 
or click on row 1 of column B (source/reference) and sort A to Z which will put all references 
into alphabetical order by first author. Before adding a new reference ensure that it is sorted 
in ‘Reference number’ order. 

Add the new reference number in Column A, this should be one larger than the previous one 
i.e if the last one was reference 234, the new one should be 235. Add in the full reference in 
the same format as the others which is currently the style for the Journal of Environmental 
Management. This can either be done manually or using the output styles from Endnote, 
ProCite, Refworks or other bibliographic manager. An example of reference format for the 
Journal of Environmental Management is: 

Butler, J.R.A., Radford, A., Riddington, G., Laughton, R., 2009. Evaluating an ecosystem ser-
vice provided by Atlantic salmon, sea trout and other fish species in the River Spey, Scot-
land: The economic impact of recreational rod fisheries, Fisheries Research 96, 259-266. doi: 
10.1016/j.fishres.2008.12.006. 

The doi may not be available for older references. 

Add in the other fields such as abstract or summary and select from the drop down lists for 
the following entries: 

1. Type and source of evidence (1,a, 1,b etc.) 

2. Evidence summary (No evidence, weak, moderate etc.) 

3. Transferability summary (Directly applicable, partially applicable etc.) 

The transferability free text field is for entering a statement about the transferability of the 
same conclusions to the same habitat at a different location. For example, if the study is on 
peat-lands in the USA, whether the findings could be applied to peat-lands in the UK. 

Go back to the green ‘Data Entry’ tab. The reference containing the source of evidence can 
now be tagged with a number of services and goods. 

Select the ‘Habitat’ from the drop down list in Column A and the ‘Management Intervention’ 
from the drop down list in Column J. Note that Columns B-I are hidden in thist version as 
they contain data entry fields used for related projects. There are now three columns of 

  
 



 

service. Column K is the NEA list of final ecosystem services, Column L is the list of goods and 
Column M is the shortened list of combined services and goods. All can be selected from the 
drop-down lists. 

Note that any one literature source may have multiple goods and services listed as well as 
multiple management interventions. Each combination of management intervention and 
service can be entered on a separate line. So for example, a literature source that looks at 
the effects of re-wetting a peatland could have the management interventions of 're-wet 
peatland by blocking drains', 'create wetlands' and 'restore peatland vegetation'. If the study 
looked at gaseous exchange and water storage, then the output services could then include 
'climate regulation' and 'water supply'. Enter all possible combinations for which there is 
evidence in the literature, each on a separate line.  

Note that goods are not nested within final services. Such that if you tag a source with 
‘Detoxification & purification in air, soils and water’ and ‘drinking water’ and the same 
source with ‘Detoxification & purification in air, soils and water’ and ‘pollution and noise 
control’ In the ‘Query’ tab, the entry under ‘Detoxification & purification in air, soils and 
water’ will appear twice in the Final Services table. In this case, the source only needs to be 
tagged once with ‘Detoxification & purification in air, soils and water’. The next tag can omit 
the final service and just tag ‘Pollution and noise control’. 

Next put the outcome from the drop down lost in Column N which can be positive, neutral 
or negative. The decision as to whether the effect is strong (++ or –) or weak (+ or -) is largely 
subjective but must be justified by the evidence. If there is any doubt on the magnitude of 
the effect it is better to err on the side of caution and assume it is weak. Strong effects may 
be open to misinterpretation. 

In column P, type in the reference number you just input in the 'references' tab, and the 
reference will appear in Column Q. 

The summary can now be entered into column R which is a short paragraph explaining what 
the evidence says. An example might be: 

‘There appeared to be no difference between a closed scallop fishery and a seasonally fished 
area in terms of scallops or other diversity. Most of the variation came from the dynamic 
environment of the seabed and seasonal changes.’ 

This summary is displayed at the output of running a query. If the summary is appropriate 
for all combinations of interventions and services/goods, then it can be copied down to all 
the other entries of that reference. It can however also be edited so that each intervention 
and services/goods combination has a different summary if so wished. 

  
 



 

The columns S-Z will be populated automatically, this is a way of counting the number of 
each interactions which is used in the operation of the query. It can be hidden if not 
required. 

Optionally you can then go back to the query tab and check to see that the new reference 
appears when you query that habitat/intervention/service interaction. 

Editing the drop down lists 
All the entries from the drop down lists are stored in the 'Service list' tab. 

These are managed from the Formulas >Name Manager option. 

If you wish to change or extend a list, or delete an entry, go to the 'Services' tab and select 
the list you wish to amend – they are named logically. Add your new entry to the bottom, or 
amend an existing entry. 

If you have added a new entry, go to the Formulas>Name Manager, select the name you 
wish to edit and then extend the cell reference for that name to include the new one. 

If you have just changed an existing entry, you do not need to do anything with the 'names' 
but you will have to search and replace the old entry with the new on the 'Date Entry' tab. 

How the Spreadsheet Works 

Versions and Macros 
The spreadsheet requires Excel 2007 or above. The main limitation preventing the use of 
previous versions is the limited amount of text that can be displayed per cell, and the use of 
the COUNTIFS() function which is a multiple conditional statement function only 
implemented  in Excel 2007 or above. This also affects the transfer of the spreadsheet to 
Openoffice or Libreoffice which do not implement this function. An equivalent to COUNTIF() 
is the SUMPRODUCT()  function which is implemented in both Excel and open document 
formats. Using this would make the spreadsheet transferable between more formats, but 
the arguably simpler syntax of the COUNTIFS() function has been used here for ease of 
editing. 

There is a simple macro implemented in the 'Literature' tab which needs to be enabled on 
opening the spreadsheet. It may be blocked depending on the security settings. Disabling 
this macro will not affect the way the spreadsheet works, it will only affect how some of the 
data is displayed or formatted. 

References Sheet 
The ‘References’ tab is formatted as a table, which means that it can be sorted by each 
column easily. This is to enable the references to be checked to see if they already exist in 

  
 



 

the database. Any number of new columns can be added depending on the information 
needed. The important column is the reference number as this is used to pull the reference 
out from this sheet when running queries or inputting data in the ‘Data Entry’ sheet. All the 
data is pulled from this sheet, nothing is pulled to here from anywhere else. It does however 
have data entry in some parts using 'names' which are taken from the 'Services' tab. See 
below for how these operate and how to edit them. 

Data Entry Sheet 
The drop down lists for the data entry sheet are held on the ‘Service List’ sheet. They can be 
added to and altered. As there is no dynamic link between the lists and the entry, they 
simply transfer text from the list held on the ‘Service List’ sheet to the ‘Data Entry’ sheet, 
they can be altered without destroying data already entered. However, this also means that 
data entered via them will have to be re-entered if the spelling changes on existing entries, 
or if an entry is removed. This can be done quickly via Home>Find & Select if needed. 

The lists on columns A and J are linked, such that if ‘Freshwater’ is selected in Column A, 
only the management interventions associated with Freshwater appear in the list in Column 
J. This is done via the ‘=INDIRECT()’ function when formatting the drop down lists in the 
Data>Validation>Data menu. This requires the drop down lists on the ‘Service List’ sheet to 
be selected and formatted as ‘Names’ which can be managed via the Formulas>Name 
Manager menu. Note that if one list is used as a condition for another, such as ‘Habitat’ 
being used to control what can appear in the ‘Intervention’ list, then the first list cannot 
have any spaces in it. Instead the underscore “_” or other character must be used. 

If new management interventions, services or habitats are added, the ‘Names’ will need to 
be extended to cover the new range when they are entered into the current lists in the 
‘Service List’ sheet. This can be done via the Formulas>Name Manager menu to edit the 
columns and rows that the lists are in. 

Entering a new source 
The user enters a new source by using the drop-down lists in columns A for Habitat, J for 
management intervention, K for NEA services, L for NEA goods and M for combined services 
and goods. 

When the reference number is entered into Column P, Column Q does a =VLOOKUP() 
function on that reference number in the ‘References’ sheet and returns the reference from 
Column B (column 2 in the VLOOKUP function).  

Each entry now needs a separate unique index to identify it and allow searching by the 
query function. 

For the single list of Services and Goods (Column M) the process is as follows. Column W 
creates a new list by concatenating the habitat and management intervention with the 

  
 



 

service using the =CONCATENATE() function. This will bring together what is in Column A 
with a ’ with ‘, Column J with an ‘ on ‘ and what is in Column M. So if A2 is ‘Freshwater’ and 
J2 is ‘Restore peatland vegetation’ and M2 is ‘Erosion Control’, then W2 will become 
‘Freshwater with Restore peatland vegetation on Erosion Control’. You could use the 
ampersand (&) function to do the same thing. 

Column X then counts how many of each combination there are and appends an underscore 
to the end using the ‘&’ function and then adds a number, ‘_1’ to the first ’_2’ to the second 
and so on using a COUNTIF() fucntion. This is needed to pull the reference number out from 
this sheet when the literature is looked at from the ‘Query’ sheet. This function works by 
first adding a ‘_’ to the end of whatever is in column W, so ‘Freshwater with Restore 
peatland vegetation on Erosion Control’ becomes ‘Freshwater with Restore peatland 
vegetation on Erosion Control_’. Excel then uses the COUNTIF() function to count the 
number of times that each combination occurs in column W. This function is used in such a 
way that for each cell in Column W, it only looks at rows that occur before it, not the whole 
column. So as the function moves down the column, the first one of each type listed in 
Column W it finds will be given the value 1, which will be appended to the end of the name 
in Column X. This is because the ‘range’ specified in the COUNTIF() function only includes 
the preceding rows, not the whole column. For the second one it finds, it will count that 
there are two in the rows of W before its present location, so it will have ‘2’ appended to the 
name, and so on. 

The two columns (W and X) do not need to be visible, so can be hidden from view but it is 
useful to have them displayed for error checking. 

The same process is used for the separate NEA services list (Column K) and Goods (Column 
L) which are processed and counted into Columns S and T and Columns U and V respectively. 

The Simple Query Sheet 
The selection of both the Habitat in Cell A3 and Management Intervention in Cell B3 are 
formatted in the same way as those on the ‘Data Entry’ sheet as drop down lists held on the 
‘Service List’ sheet. They are linked again using the ‘=INDIRECT()’ function such that the list 
that appears in Cell B3 depends on what is shown in A3. They can be managed from the 
‘Data>Data Validation’ tool. 

The main functions in this sheet are those that count how many of each reference there are 
for each Habitat*Intervention*Service Interaction and displays them in Columns C-G listed 
by each Service in Column B. 

This is done via the =COUNTIFS() function which can return a value based on multiple 
criteria. The sheet that the COUNTIFS function looks at is the ‘Data Entry’ sheet. 

  
 



 

As an example, the function in Cell C6 on the ‘Simple Query’ tab needs to return the number 
of sources that refer to the following conditions: the Habitat shown in A3, the Intervention 
shown in B3, the Service shown in B6 and which are also entered as ‘++’. 

The COUNTIFS() function in each row of Columns C-G looks at Column J in the ‘Data Entry’ 
sheet to find the number of sources that are listed as being the same as that entered in the 
‘Intervention’ cell (B3). It then looks to see which of those ALSO have the same service listed 
in Column M of the ‘Data Entry’ sheet as that of Column B in the Query. The last part of the 
COUNTIFS() function then looks to see how many are ALSO listed as ++. This count is then 
returned to the cell. This function is then carried on across Columns C-G and down to the 
end of the list of services. Note that all the ranges queried using COUNTIFS have to be the 
same range, so B1:29, C1:29 etc. with work but B1:29 and C1:30 will result in an error. 

The colour of the counts is changed automatically via the Home>Conditional Formatting 
option using a two colour rule, currently set to a minimum of 0, maximum of 10, with grey 
to green for positives, grey to blue for neutral and grey to red for negatives. 

The one line summary on Column H just uses =VLOOKUP() again, looking up the 
‘Intervention’ shown in B3 in a table of one line summaries held on the ‘Service List’ sheet 
and returning the value in the column number corresponding with the service shown in 
Column B. 

The links back to the evidence are hyperlinks back to places in the ‘Literature’ sheet. This is 
populated whenever the Habitat in A3 or the Intervention in B3 are changed. The hyperlinks 
take the user to the literature for the combination of Habitat*Intervention*Service shown 
on the query sheet which are written as Column Headings whenever A3 or B3 are changed, 
with one heading per Habitat*Intervention*Service interaction.  

The ‘Query’ tab works in exactly the same way as the ‘Simple Query’ tab using the same 
‘Date Entry’ sheet but different columns for the NEA services and goods list. 

The Literature Sheet 
This part of the spreadsheet has been the most complex to implement. It would be possible 
to use Array functions to do this part, possibly more simply, though the fact that each 
Habitat*Intervention*Service interaction will have more than one reference makes this 
challenging. The more straightforward way is to use the reference count/index Column W 
(Column T and V for the NEA lists) on the ‘Data Entry’ sheet. This is less neat but means that 
simpler functions can used which can be more easily edited and de-bugged. 

  

  
 



 

It works in the following stages (which apply equally to the ‘Evidence’ and the ‘Literature’ 
tabs: 

1. In the simple query sheet (or query sheet), the habitat and management 
intervention in cells A2 and B2 are selected. 

2. Columns of Row 2 in the ‘Literature’ sheet have the habitat (A2) intervention 
(B2) and service (B6 and so on) concatenated together in the same way as in the 
‘References’ sheet, with a  ‘ with ‘ and an ‘ on ‘ placed between them. For example, 
B2 may become ‘Freshwater with Restore peatland vegetation on Food’ if the ‘Query’ 
sheet has ‘Freshwater in A3 and ‘Restore peatland vegetation’ entered into B3. 
‘Freshwater with Restore peatland vegetation on Fibre’ then appears in Cell D2 and 
so on across the sheet for all the services listed. 

3. The column two along from the concatenated Habitat*Interaction*Service 
entry then counts how many of that combination there are in Column X of the ‘Data 
Entry’ sheet i.e. if there are four entries of ‘Freshwater with Restore peatland 
vegetation on Food’ in Column X of the ‘Data Entry’ sheet, then the value of 4 will be 
returned here. This uses a simple COUNTIF() function based on the concatenated 
phrase which has just been placed in D2 (and others) 

4. Excel now populates Row 3 of the ‘Literature’ sheet. This is done via the 
INDEX() and MATCH() functions on the Reference Number. 

5. The first part of the function is a simple FOR loop, that looks at whether the 
number of sources in Row 1 for that Habitat*Interaction*Service entry is greater 
than the line number (Column A which is hidden). If it isn’t then the rest of the 
function will proceed, if not, it will stop. 

6. The MATCH() function looks at Column X in the ‘Data Entry’ sheet. It looks for 
a match between what is in Column X and the combination of the entry in the 
habitat*interaction*service with the Line Number (Column A). So if ‘Freshwater with 
Restore peatland vegetation on Fibre’ is in Row 2, and the function is in Row 3 (which 
has line number 1), then it looks for ‘Freshwater with Restore peatland vegetation on 
Fibre_1’ in Column X of the ‘Data Entry’ sheet. In Row 4 it will look for Freshwater 
with Restore peatland vegetation on Fibre_2’ and so on. It will then return the 
position within the array specified within the MATCH function, which is Column X of 
the ‘Data Entry’ sheet. 

7. When it finds a match, the INDEX() function pulls the value out of the row 
position found by the MATCH function but from Column P of the ’Data Entry’ sheet, 
which is the Reference number which is then placed in the Column. 

  
 



 

8. The columns to the right of the reference number are then populated from 
the ‘References’ sheet using the VLOOKUP() function, looking for the reference 
number in Column A of the ‘References’ sheet. The IF($Axx>$C$2,””,……) function in 
front of VLOOKUP() is there to stop the rest of the cells showing N/A when no data is 
available. This just makes it look tidier. 

9. The hyperlinks back to the entry for each reference number in the 
‘References’ tab are generated using the ‘HYPERLINK’ function by using the ADDRESS 
function from matching the reference number to one on the ‘Reference’ tab. A 
typical form of this function is: 

 
=IF($A3>F$1,"",HYPERLINK("#"&ADDRESS(MATCH(B3,References!$A:$A,0),1,,,"Refer
ences"),"Link")) 

10. There is a macro function within the 'Literature' tab. This simply helps with 
the formatting and if security settings do not allow it to run, then it will not affect the 
overall function of the spreadsheet but it will slightly affect the way the output is 
displayed. The macro simply places the active cell at the top-left part of the 
spreadsheet when the hyperlink from the 'Query' tab for a particular service brings 
the user to the 'Literature' tab. As this is the 'habitat_management-
intervention_on_service' entry, the macro then moves the active cell one row down 
and one column to the right to position it correctly over the highlighted interaction.. 

The macro ‘ShowTopLeft’ has the followed Visual Basic structure: 

Sub ShowTopLeft() 

    'Macro to make the selected cell one row down from top left 

    'Also uses the autorun feature in a Private sub in the literature sheet 

    'Makes the literature sheet active 

    'Sheets("Evidence").Activate' 

    'Goes to the selected cell and makes it top left 

    Application.Goto Reference:=Range(ActiveCell.Address), Scroll:=True 

    'Moves the selection down one row and to the right one column, to highlight the selection 

    Selection.Offset(1, 1).Select 

End Sub 
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